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Introduccion

La fotogrametria es una técnica cuyo objetivo es estudiar y definir con precision
la forma, dimensiones y posicion en el espacio de un objeto cualquiera utilizando
esencialmente medidas hechas sobre una o varias fotografias de ese objeto
(Otero et al., 2010). Uno de los principios fundamentales de la fotogrametria es
la triangulacién; es decir, a partir de fotografias tomadas desde, al menos, dos
posiciones diferentes se pueden establecer las lineas que unen puntos del objeto
3D con sus correspondientes homélogos en las imagenes. Si se calcula la
interseccion analitica de estas lineas, se determinaran las coordenadas 3D de
los puntos de interés del objeto (Caracuel et al., 2002).

El término fotogrametria no es una palabra de reciente creacion. Fue utilizado
por primera vez durante la segunda mitad del siglo XIX por el arquitecto Albrecht
Meydenbauer, quien tuvo la idea de utilizar las fotografias para la documentacion
de las edificaciones, y de este modo, en caso de que se vieran dafiadas podrian
ser restauradas. Enfocado en esta idea y no sin superar grandes obstaculos,



fundé la primera institucion mundial dedicada a la documentacion de objetos del
patrimonio cultural (Albertz, 2002).

La idea original de la preservacion del patrimonio cultural, se vio auxiliada por
nuevas herramientas en el siglo XXI, como el uso del escaner que ha llegado a
reemplazar a la fotogrametria en muchos casos. El uso del escaner presenta
bastantes ventajas; se trata de un proceso rapido, preciso y completo, sin
embargo, aun tiene algunos problemas y limitaciones. En primer lugar, el alto
costo que representa el adquirir el equipo y su rapida obsolescencia, en segundo
lugar, la experiencia necesaria para sacar el maximo provecho de la tecnologia.
En tercer lugar, se encuentra la disponibilidad, ya que en algunos paises pueden
resultar complicados de encontrar y transportar y por ultimo algunos escaneos
aun necesitan una cobertura fotografica para agregar la textura al objeto (Pisa et
al., 2010). La ventaja de la fotogrametria es que no es necesario hacer una nueva
inversion ya que el proceso puede llevarse a cabo con elementos basicos que
ya suelen tenerse en la mayoria de los casos. Estos son esencialmente dos: una
camara fotogréafica y una computadora. De este modo se reducen enormemente
los gastos necesarios, los cuales pueden llegar a ser cero en realidad, si ya se
cuenta con estos elementos como parte de las herramientas de cualquier
investigador en la actualidad.

La generacibn de modelos tridimensionales actualmente comienza a
diversificarse y difundirse a gran escala, debido a las recientes técnicas y
herramientas que permiten la impresion en 3D. La obtencién de réplicas de
objetos en tercera dimension actualmente esta ayudando a los investigadores
dentro de diversos campos. Un claro ejemplo es en la medicina, donde ahora es
posible imprimir réplicas para producir protesis precisas para cada individuo a un
bajo costo. Otra aplicacion, esta en la paleontologia ya que permite realizar
analisis morfoldégicos mas precisos que a partir de simples fotografias en dos
dimensiones. Actualmente existen programas especializados en realizar analisis
de morfometria geométrica para poder comparar dos o mas elementos similares
y asi reconstruir los fragmentos faltantes de un fosil o establecer las relaciones
evolutivas que existen entre éstos a través de cladogramas. Las imagenes 3D
proveen las bases para la reconstruccion digital de organismos con mas
objetividad de lo que era posible anteriormente con la informacién incompleta
gue usualmente los paleontélogos se veian obligados a trabajar (Cunningham et
al., 2014). Por ultimo, una aplicacion bastante util para a fotogrametria es ayudar
a la difusion del material y el conocimiento de la diversidad del puablico en general

Antecedentes

Anteriormente la paleontologia virtual representaba un gran gasto para los
investigadores, por lo que no se presentaban los resultados al publico (Rahman
et al., 2012). Con el desarrollo de los programas gratuitos y la accesibilidad a las



tecnologias de la informacion y la comunicacion esta aumentando cada vez mas
su uso dentro del area, prueba de ello es la cantidad de articulos recientes
referentes al tema que se pueden encontrar publicados.

Las técnicas fotogramétricas digitales constituyen una metodologia valiosa para
la reconstruccion morfoldgicay la caracterizacion métrica de objetos, que ha sido
escasamente aplicada en ciencias de la tierra y especialmente en paleontologia
(Caracuel et al., 2002). Desde principios del siglo XX algunos investigadores se
planteaban la utilidad de generar modelos tridimensionales de material fosil,
especialmente desde el punto de vista de los analisis morfométricos mas
precisos. Durante los ultimos afios han surgido alrededor del mundo diversos
proyectos que tienen por objeto el crear replicas digitales tridimensionales de
fésiles con diversos objetivos tales como son la divulgacién, la docencia y la
investigacion (Caracuel et al., 2002, Cunningham et al., 2014,

Remondino et al. (2010) comprobaron la eficacia y utilidad de la fotogrametria
aplicada en la icnologia. Mediante una combinacion con técnicas de escaneado
con laser, logré obtener excelentes resultados de huellas de dinosaurio para la
preservacion y difusion del registro fosil. Afirmaron que con ésto en un futuro se
podran interpretar y deducir distintas caracteristicas en el andar de estos
animales.

En 2013 Joint Information Systems Committee (JISC) y el Servicio Geolbgico
Britanico lanzaron la primera coleccion virtual de fosiles al publico (Fossil launch
marked at Cambridge Museum, 2013), GB3D Type Fossils se trata de una
coleccion de cientos de modelos en 3D y de miles de imagenes en su gran
mayoria pertenecientes a invertebrados. En su sitio web muestran ademés de
las imagenes y los modelos, la identidad taxondmica de la especie, y en caso de
estar disponible, la procedencia del espécimen, su numero de registro, la
localidad donde se colecté y el nombre del colector. Su especialidad es mostrar
los tipos que se encuentran en museos britanicos (holotipos, paratipos, neotipos,
sintipos, lectotipos, paralectotipo, topotipo e isotipo) y también proporcionan un
enlace para descargar los archivos y trabajar con ellos. El problema con esta
base es la interfaz y disefio ya que lo hace poco llamativa y monétona.

Por su parte el Museo de Paleontologia de la Universidad de Michigan lanzo
UMORF donde de igual manera se presentan tanto modelos en 3D como
imagenes. Muestran modelos de gran calidad obtenidos por distintos métodos,
tanto con escaner como por tomografias de rayos-X, y por fotogrametria (Project
history, s.f.). Su fortaleza es su interfaz, ya que permite por un lado manipular el
modelo desde el navegador sin necesidad de instalar algunos complementos, y
por otro permite realizar mediciones del fosil. En primer lugar, al ingresar en el
sitio web, brinda el ejemplo con un mastodonte completo el cual es posible rotar,
acercar e incluso medir; es posible seleccionar algin hueso en especifico y se
abrirhA en otra ventana ahora con la textura original del elemento.
Desafortunadamente es una base que crece lentamente y el mastodonte es el



unico ejemplar “completo” que muestran, el resto se trata de partes aisladas de
otras especies.

Otro recurso en linea es Digimorph. se trata de otra base de datos hecha en
colaboracion con la Universidad de Texas, en la cual se muestran los modelos
obtenidos principalmente con un proceso de rayos-X a manera de capas para
reconstruir el objeto llamadas tomografias (Digital Morphology - A unique
biological visualization library, s. f.). Esta técnica tiene la ventaja de que muestra
la densidad del objeto, no solamente la parte visible, sino las cavidades no
accesibles a la vista; la mayoria de los archivos son mostrados a manera de
videos, con varias vistas a elegir, ya sea horizontal, coronal o sagital. La mayoria
de los ejemplares mostrados son craneos. Cuenta tanto con invertebrados como
con peces, mamiferos, reptiles, anfibios, aves, etc., vivos y extintos. Un problema
gue se puede presentar con Digimorph es el uso de plug-in (complemento para
el explorador de internet) que actualmente los navegadores estan bloqueando
debido a fallos de seguridad, lo cual puede complicar la visualizacion correcta de
sus modelos en linea. Ademas, tiene el inconveniente de que se tratan de videos
en su mayoria, los cuales sélo pueden adelantarse o atrasarse, limitando de esta
manera las posibilidades de manipulacion y exploracion al usuario.

En cuanto a trabajos en México existen pocos casos en lo que respecta a la
digitalizacion de fésiles. Gutiérrez-Garcia et al. (2013, 2015) han trabajado con
un método que permite obtener digitalizaciones de muy buena calidad, el punto
fuerte de su trabajo se fundamenta en la utilizacion de franjas de luz proyectadas
sobre el material, de este modo se puede recoger informacion muy precisa sobre
la forma y los detalles de la superficie, ademas de dar excelentes resultados en
muestras pequefias como lo demuestran utilizando una mandibula de ratén. Sin
embargo, para una persona con pocos conocimientos sobre la técnica, resulta
complicado de entender y alin mas de experimentar con su propuesta. El uso de
algoritmos y programas matematicos avanzados dificultan en gran medida el
aprovechamiento de sus avances por personas que no pretendan profundizar el
tema.

Estos son algunos de los antecedentes en cuanto a bases de datos de fosiles en
3D. Adicionalmente existe informacion en articulos cientificos que muestran las
posibilidades de estudios que se pueden realizar con el uso de modelos virtuales.
Un claro ejemplo es el reciente trabajo de Mounier y Lahr (2016) quienes, a
través de modelos digitales de craneos de diferentes tipos de hominidos,
lograron reconstruir mediante un analisis con software de morfometria
geometrica, el aspecto que probablemente tenia un antepasado comun entre el
Homo sapiens y H. neanderthalensis, conocido como H. heidelbergensis.

Justificacion



A pesar del avance en las técnicas para la replicacion virtual de material fésil,
son pocos los trabajos que actualmente se publican en los que se hayan
utilizado éstas, en comparacion con el nimero de trabajos tradicionales que se
suelen publicar, esto genera un sesgo en la informacion que se entrega al
lector.

Por otro lado, la pérdida de material fosil por deterioro y dafio causado por el
manejo, son un problema constante en las colecciones cientificas. Por esto,
mediante un manual, se pretende mitigar en gran medida estos problemas.

Objetivos

Objetivo General

« Elaborar un manual para promover el uso de las nuevas tecnologias en la
investigacion y la docencia para proporcionar una metodologia que
ayudard a coleccionistas e investigadores a generar material digital que
facilite la difusion de la paleontologia.

Objetivos especificos
* Investigar y ubicar la metodologia mas sencilla y de bajo costo para la
creacion de réplicas virtuales
* Investigar y analizar los trabajos previos sobre el tema.
+ Identificar la mejor propuesta de bajo costo para la creacién de réplicas
virtuales tridimensionales para su uso en paleontologia

Materiales y métodos

+ Serealizo unarevision literaria sobre los antecedentes del tema, asi como
el analisis de diferentes trabajos realizados a partir de las mismas técnicas
y aplicados a campos similares dentro de la paleontologia y anatomia en
general, con la finalidad de realizar una comparacion de los diferentes
productos y los beneficios generados a partir de la creacion de bases de
datos de material en 3D.

* Se investigaron las diferentes alternativas y propuestas ofrecidas por
diferentes desarrolladores de programas enfocados a la realizacién,
edicion y manipulacion de mallas 3D a partir de fotografias, tratando de
encontrar aguellos programas que se ajusten mejor a las necesidades del
campo de la paleontologia y al perfil del publico a quién va dirigido el
manual. Lo que significa que se dio prioridad a programas que requieran
un minimo conocimiento sobre computacion, asi como aquellos que



ofrezcan licencias gratuitas o a bajos costos, igualmente aquellos
programas con interfaces méas amigables con el usuario inexperto, pero a
la vez lo suficientemente completos y potentes para generar modelos de
calidad.

* Una vez completada la informacién previa se procedio a la redaccion del
manual, el cual fue escrito de la manera méas sencilla y grafica posible
para su facil entendimiento por cualquier persona, aun aquellas que
tengan minimos conocimientos de computacion. Al final se agregaron
ejemplos complementarios para que el lector/usuario pueda comprender
de manera facil lo que se espera obtener durante cada paso del
modelado.

Resultados

Como resultado de la investigacion, pruebas de software y redaccion, se genero
un manual de fotogrametria en paleontologia donde se realiza una comparativa
y andlisis de las diferentes plataformas donde se pueden encontrar réplicas de
material fosil y similares. Se detalla el material necesario, asi como las técnicas,
meétodos y sugerencias para realizar una réplica lo mas fiel posible y de buena
calidad.

El manual se redacté tratando de manejar un lenguaje claro y simple ademas de
reforzar y aclarar los pasos mediante imagenes para facilitar el entendimiento al
usuario de cada paso y procedimiento.

Al final se anexan ejemplos practicos en el cual se pueden apreciar los
resultados obtenidos en cada paso, asi como links a la web (Museo Virtual
Nacional) donde se encuentran alojados dichos modelos y las fotografias en
caso de que se quiera practicar.



Manual de fotogrametria
en Paleontologia

E. Miguel Diaz de Leon Munoz
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Introduccién

La fotogrametria es una técnica cuyo objetivo es estudiar y definir con precision
la forma, dimensiones y posicion en el espacio de un objeto cualquiera, utilizando
esencialmente medidas hechas sobre una o varias fotografias de ese objeto
(Otero et al.,, 2010). Partiendo de este concepto, el enfoque que se le da al
presente trabajo es el crear modelos virtuales tridimensionales (3D) a partir de
imagenes procesadas por software.

El término “fotogrametria” no es una palabra de reciente creacion. Fue utilizado
por primera vez durante la segunda mitad del siglo XIX por el arquitecto Albrecht
Meydenbauer, quien tuvo la idea de utilizar las fotografias para la documentacion
de las edificaciones. De éste modo, en caso de gue se vieran dafiadas podrian
ser restauradas. Enfocado en esta idea y no sin superar grandes obstaculos,
fundé la primera institucion mundial dedicada a la documentacién de objetos del
patrimonio cultural (Albertz, 2002).

Después de 150 afios de la concepcién de la idea, los métodos utilizados para la
preservacion del patrimonio se han diversificado. A principios de los 90’s se dio
una de las grandes innovaciones con el uso del Scanner o escéner que, a
diferencia de las camaras, los escaneres cominmente emiten algun tipo laser o
luz y cronometran el tiempo que tarda en regresar y asi poder calcular las
distancias y formas de los objetos. La fotogrametria, por su parte, ha ampliado
su campo de aplicacion. Actualmente uno de los usos mas diversificados es la
fotogrametria aérea; ésta se enfoca en el andlisis de las fotografias tomadas a
bordo de aeronaves o satélites, las cuales, combinadas con los modernos
sistemas de geolocalizacion, son empleadas para el estudio de los terrenos
(Otero, et al. 2010)

Dentro de las ciencias biolégicas, quiza el area donde mayor difusién ha tenido
es dentro del sector forestal. Mediante la comparacion de fotografias aéreas a
tomadas a lo largo de un periodo de tiempo, como afos o las estaciones, se
pueden hacer analisis de deforestacion, cobertura del terreno e incluso
diversidad de especies en una locacion determinada. Esto implica que bidlogos
y agronomos pueden contar con las herramientas necesarias para estimar el
estado de preservacion de los bosques y terrenos y finalmente poder plantear
estrategias para la conservacion de la vida silvestre (Otero, et al. 2010)
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Fotogrametria VS escaner

La idea original de la preservacion del patrimonio cultural, se vio auxiliada por
nuevas herramientas en el siglo XXI, como el uso del escaner. Este es uno de
los que mas se ha diversificado y popularizado y ha llegado incluso a reemplazar
a la fotogrametria en muchos casos. Ademas del escaner y la fotogrametria
existen gran variedad de técnicas dedicadas a la reconstruccion virtual 3D, cada
una con sus ventajas y desventajas. Desde el uso de rayos X y las tomografias,
hasta el uso de resonancia magnética, el problema con muchas de éstas es la
relacion de costo/beneficio, tanto costos de compra del equipo como costos cada
vez que se utiliza. Por ejemplo, el costo de un equipo de resonancia magnética
va desde 10,000 a 100,000 libras esterlinas (aproximadamente $250,000 a
$2’500,000 pesos mexicanos), otras como el haz de iones resultan destructivos
para el material a digitalizar (Cunningham et al., 2014), de modo que, aun cuando
existe una amplia gama de opciones, no todas resultan viables para el
presupuesto de alguna investigacion o para la preservacion del material fosil.

El uso del escaner presenta bastantes ventajas, se trata de un proceso rapido,
preciso y completo, sin embargo, aln tiene algunos problemas y limitaciones. En
primer lugar, el alto costo que representa el adquirir el equipo y su rapida
obsolescencia. En segundo lugar, la experiencia necesaria para sacar el maximo
provecho de la tecnologia. En tercer lugar, se encuentra la disponibilidad, ya que
en algunos paises del mundo pueden resultar complicados de encontrar y
transportar. Por ultimo en algunos escaneos aldn necesitan una cobertura
fotogréfica (Pisa et al., 2010) para poder agregar una textura a la malla 3D.

La obtencién de imagenes mediante técnicas de fotogrametria se dividen en tres
grupos. Unos trabajan con algoritmos individuales y resuelven tareas especificas
dentro del proceso de reconstruccion. Otros programas que crean un modelo 3D
a partir de fotografias y por ultimo programas online, donde se envian las
imagenes por internet, se procesan de forma remota en “la nube” y de este modo
se obtiene el modelo 3D (De la Torre-Canntero et al., 2015).

Las técnicas modernas de fotogrametria presentan diversas ventajas en relacion
a las técnicas de escaneado mas actuales. Basicamente la primera ventaja y la
de mas peso es la relacion de costos. En primer lugar, el costo de un escaner
econdmico es de mas de $7000 para los equipos mas basicos. Se trata de
equipos fijos con 2 escaner y una plataforma para colocar el objeto a escanear,
los cuales dan una precision de 0.5 mm, pero con la desventaja de la limitacion
en el tamafo del objeto (250 mm de diametro X 205 mm de altura) ademas del
peso que soportan es de 3 kg, lo cual es una clara desventaja si lo que se
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requiere es trabajar con fésiles ya que estos son muy diversos en pesos Yy
tamafos (Figura 1).

Figura 1. Escaner PrintME 3D - Bq Ciclop 3D. Costo aproximado $7,500 MN

En segundo lugar, es posible encontrar equipos de mucha mayor precisién con
la ventaja de ser portatiles y manejarse con la mano, el gran inconveniente que
presentan es su elevado costo, llegando a costar mas de $300,000 lo cuél en
muchos casos se sale del presupuesto de investigadores y muchas veces no
justifica su compra al no ser una prioridad en la investigacion que se lleva a cabo
(Figura 2).

Figura 2. Escaner laser Minolta Vivid 910. Costo aproximado de $150,000 MXN

La segunda ventaja por parte de la fotogrametria es que no es necesario hacer
una nueva inversion ya que el proceso puede llevarse a cabo con elementos
basicos que ya suelen tenerse en la mayoria de los casos. Estos son
esencialmente dos: una camara fotografica y una computadora. Para obtener
mejores resultados es necesario contar con un mejor equipo.

Aln si se asume la adquisicion de un nuevo equipo fotogréafico, una crucial
diferencia entre la inversion al comprar un escaner o una camara digital de alta
calidad radica en el rango de utilidades que brinda cada uno al investigador.
Gastar en un escaner de miles de pesos puede resultar poco beneficioso pues
SU uUSo se va a centrar unica y exclusivamente en la creacion de modelos 3D, por
otro lado, invertir en una camara fotografica resulta mas redituable, pues ésta se
puede continuar usando en otros procesos durante la investigacion e incluso
durante la recreacion. Claro estd que para aquellos que se dedican a la
investigacion y publicacion de articulos una camara fotogréafica con las funciones
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minimas ya es parte del material con que se debe contar, por lo que, no es
necesario hacer una gran inversion.

Objetivos de la fotogrametria en la paleontologia y la docencia

A més de 200 afios de los primeros trabajos de Cuvier y a mas de 100 afios de
los de Cope y Marsh la paleontologia ha realizado grandes avances en distintos
campos, desde evolucién hasta de preservacion del material s6lo por mencionar
algunos. Sin embargo, un campo que ha dado pasos mas lentos ha sido el de la
difusiéon. La publicacion de articulos cientificos se sigue haciendo en revistas,
con la diferencia de que ahora se publican en internet y el contenido es digital.
Fuera de esto, los articulos siguen conservando el principio basico; por ejemplo,
en el caso de las descripciones, se presenta el texto descriptivo de las partes y
ahora, a diferencia de los primeros afios de la paleontologia donde se usaban
dibujos (los cuales cabe resaltar tienen gran mérito y aportan grandes detalles),
se utilizan generalmente fotografias, ya sean a blanco y negro o a color, desde
enormes huesos hasta cortes microscopicos. Actualmente se esta proponiendo
que los autores compartan parte de sus resultados de manera digital, esto
incluyendo los modelos virtuales generados para que sus resultados puedan ser
sometidos a analisis mas objetivos, especialmente aquellos que trabajen con
descripciones de nuevas caracteristicas anatomicas (Cunningham et al. 2014)

El problema con el que muchos paleont6logos (especialmente los principiantes)
se encuentran al momento de tratar de identificar un hueso o en ocasiones un
simple fragmento, es que no se puede asignar a una parte del cuerpo. Es aqui
donde juega un papel fundamental la anatomia comparada. Se recurre a atlas
de osteologia, se analizan los cuerpos completos tratando de asignarlo a alguno,
sin embargo, bien sabido es que existen en ocasiones grandes diferencias y
especializaciones entre la anatomia entre los organismos. A veces, ya con una
vaga idea de “qué puede ser” se recurre a una literatura mas especializada, se
revisan articulos, se leen descripciones y se compara con las fotografias que
proporcionan. Pero en ocasiones esto no es suficiente, pues las fotografias dan
s6lo una vision en dos dimensiones (2D) del objeto. En ocasiones el autor
proporciona dos angulos del mismo elemento, pero generalmente solo muestra
una vista, muchas veces con lo que se cuenta es con un fragmento en vista
dorsal y el autor s6lo muestra la vista ventral, lo cual complica una comparacion
mas objetiva. Numerosos fragmentos de huesos son almacenados y guardados
en las colecciones cientificas sin que se logre identificar “qué parte son” y mucho
menos la identidad taxondmica. Aqui es donde la fotogrametria puede llegar a
jugar un papel importante, contando con bases de datos especializadas (3D) se
puede obtener material para realizar las comparaciones adecuadas e incluso
analisis de morfometria geométrica con software especializado, con lo cual se
podria realizar un analisis de coincidencia de ciertas formas o puntos.

Anteriormente el investigador tenia que acudir directamente al museo o coleccion
para realizar una comparacion de los ejemplares, lo cual se vuelve cada vez
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menos necesario con el uso de los objetos 3D. Los modelos 3D permiten ademas
una mejor conservacion del objeto real, tal como sucede con las réplicas de los
museos, las cuales tienen la finalidad de preservar el original en las mejores
condiciones posibles.

Otros usos de los modelos digitales 3D se centran en la posibilidad de
reconstruccion (virtual) de las partes no conservadas de los ejemplares, cuando
se disponga de esa informacion en otros restos fosiles. De este modo se puede
obviar las pérdidas de informacion debidas a procesos tafonomicos destructivos
sobre los restos, que en ocasiones limitan su tratamiento taxonémico. De igual
modo pueden ser corregidas sobre el modelo 3D las distorsiones (aplastamiento,
fractura) que habitualmente afectan a los fosiles (Caracuel et al., 2002).

Con la reciente implementacion y difusion de las impresoras 3D, se podran crear
réplicas de objetos depositados en sitios lejanos, sin siquiera manipularlo y
exponerlo a un desgaste o fractura por un inadecuado manejo o descuido, todo
esto sin mencionar las técnicas de replicado que en ocasiones toman como
molde el fésil y llegan a desprenderle fragmentos. De modo que una vez se
mejoren los procesos y bajen mas los costos, se podran realizar réplicas de bajo
costo tanto para exposicién y decoracion como para investigacion, ya sean a
escala o tamafo natural, ayudando de éste modo a la difusién y la generacion
de conocimientos.

El uso de la fotogrametria en la creacion y difusion de material multimedia puede
ser una herramienta de la cual maestros y alumnos se puedan ver beneficiados.
Al respecto, De la Torre-Cantero et al. (2015) concluyen que ni el coste, ni la
dificultad técnica, suponen un impedimento para utilizar estas réplicas en
entornos educativos y los posibles usuarios de las mismas demuestran un
evidente interés en su utilizacion. El método en el que el profesor es un proveedor
de conocimiento ya elaborado estd siendo reemplazado por nuevas
metodologias de ensefianza que emplean nuevas tecnologias, tales como
proyectores y material multimedia. La ventaja de esta practica es que el docente
puede presentar material interactivo, atractivo visualmente y capaz de captar la
atencion del alumno. Debido a que el material es interactivo, el estudiante puede
manipularlo, lo que facilita la enseflanza y la comprension de la anatomia y la
osteologia de los organismos tanto extintos como recientes.

Como ejemplo del uso en la didactica y difusion tenemos que en el afio 2012
réplicas de fosiles obtenidas por tomografias fueron impresas en 3D por el Museo
Lapworth de Geologia de la Universidad de Birmingham, Reino Unido durante un
evento en el cual se ofrecieron varias actividades para los residentes locales con
lo que lograron obtener una gran participacion del publico en general,
principalmente notaron que obtuvieron un gran interés por parte del publico
infantil, ya que pudieron manejar las réplicas con sus propias manos, lo que se
considera como un gran cambio en las técnicas de ensefianza tradicionales
sobre la paleontologia, en la cual rara vez tiene el publico en general la
oportunidad de manipular un fésil real, esto supone un gran paso en la
ensefianza y comprension de la evolucion por el publico.
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(Rahman et al. 2012).

Finalmente, con la correcta aplicacion de las técnicas de fotogrametria, se
pueden realizar facilmente comparaciones y analisis de la evolucion de las
estructuras, diferencias y similitudes entre especies u organismos. Dado que
estos modelos digitales 3D de restos paleontolégicos favorecen una rapida
comparacion morfologica y morfométrica tridimensional de los fosiles, son utiles
en aplicaciones taxonOmicas y para caracterizar trayectorias evolutivas
(Caracuel, et al., 2002).

Ejemplos de fotogrametria aplicada en paleontologia

En 2013, el Servicio Geolodgico Britanico lanz6 la primera coleccion virtual de
fésiles al publico, GB3D Type Fossils (Launching the world’s first 3D virtual fossil
collection, 2013) se trata de una coleccién de cientos de modelos en 3D, y miles
de imagenes en su gran mayoria pertenecientes a invertebrados. En su sitio web
muestran ademas de las imagenes y los modelos, la identidad taxondmica de la
especie, y en caso de estar disponible, la procedencia del espécimen, su nimero
de registro, la localidad donde se colecto y el nombre del colector. Su
especialidad es el mostrar los tipos que se encuentran en museos britanicos
(holotipos, paratipos, neotipos, sintipos, lectotipos, paralectotipo, topotipo e
isotipo), proporcionan enlaces para poder descargar los archivos y trabajar con
ellos. El problema con esta base es la interfaz y disefio ya que lo hace poco
llamativa y monoétona.

Por su parte, el Museo de Paleontologia de la Universidad de Michigan lanzé
UMOREF, (Project history. s.f.) donde de igual manera se presentan tanto modelos
en 3D como imagenes. Muestran modelos de gran calidad obtenidos por distintos
métodos, tanto con escaner como por tomografias de rayos-X y por
fotogrametria. Su fortaleza es su interfaz, ya que permite por un lado manipular
el modelo desde el navegador, sin necesidad de instalar algunos complementos,
y por otro permite realizar mediciones del fésil. Brinda como ejemplo un
mastodonte completo, el cual es posible rotar, acercar e incluso medir; se puede
seleccionar algun hueso en especifico y se abrira en otra ventana, pero con una
textura. Sin embargo, la informacién crece lentamente y el mastodonte es el
unico ejemplar “completo” que muestran. El resto se trata de partes aisladas de
otras especies.

Real 3D Anatomy es otro sitio que presenta modelos 3D de buena calidad,
creado por la Universidad de Bristol (Introducing Real 3D Anatomy. 2011),
presenta una interfaz interesante. Ella muestra los objetos a manera de “capas’,
es decir, es posible quitar huesos del esqueleto completo. Ademas, se puede
seleccionar un hueso en especifico y una vez abierto muestra el nombre de



19

alguna de las  partes con soOlo pasar el cursor
sobre ella.
Desafortunadamente solo cuenta con un ejemplar en su base, el de un perro.

Digimorph, se trata de otra base de datos hecha en colaboracién con la
Universidad de Texas (Digital Morphology - A unique biological visualization
library @ DigiMorph.Org. s. f.). Este recurso muestra los modelos obtenidos
principalmente con un proceso de rayos-X a manera de capas para reconstruir
el objeto. Esta técnica tiene la ventaja de que muestra la densidad del objeto, no
solamente la parte visible, sino las cavidades no accesibles a la vista. La mayoria
de los archivos son mostrados a manera de videos, con varias vistas a elegir, ya
sea horizontal, coronal o sagital. La gran mayoria de los ejemplares mostrados
son craneos. Cuenta tanto con invertebrados como con peces, mamiferos,
reptiles, anfibios, aves, etc. tanto vivos como extintos. Un problema con
Digimorph es el uso de plug-in que actualmente los navegadores estan
bloqueando debido a fallos de seguridad, por lo cual puede complicar la
visualizacion correcta de sus modelos en linea. Ademas, la informacion se
muestra como videos en su mayoria, los cuales sélo pueden adelantarse o
atrasarse, limitando de esta manera las posibilidades de manipulacion y
exploracion al usuario.

Por dltimo, se encuentra 3D Museum, actualmente perteneciente al
Departamento de Geologia de la Universidad de California. Utilizan un escéaner
laser para producir modelos 3D de diferentes organismos, tanto vivos como
extintos (How 3D models were made. s. f.) Ademés, proporcionan una breve
informacion sobre su clasificacion. Desafortunadamente desde 2010 la pagina
no se encuentra actualizada, por lo que el uso de complementos en el navegador
de internet (que se ha detectado que cuentan con fallos de seguridad) complican
el uso de la pagina.

White et al. (2013) utilizé una metodologia en la que se basa el presente trabajo,
se sirvio de la fotogrametria; utilizé la herramienta CMVS/PMVS y Meshlab,
mismos que mas adelante se describen como utilizar. Cre6 un modelo virtual de
un metacarpal | de Rapator ornitholestoides, un raptor del Cretacico de Australia
depositado en el Museo de Historia Natural de Londres. El modelo permitio la
comparacion con el metacarpal | de Australovenator wintonensis, otro teropodo
neovenatorido recientemente encontrado en Australia, modelo también creado a
partir de tomografias computarizadas. La conclusién sugiere que los
metacarpales | de ambos organismos son suficientemente diferentes para ser
asignados como géneros diferentes. Este es un claro ejemplo de la practicidad
de la técnica para comparar especimenes y de las facilidades que brinda para
las investigaciones y comparaciones entre dos especimenes localizados en
extremos diferentes del mundo.

En cuanto a trabajos en México, se pueden encontrar pocos casos en lo que
respecta a la digitalizacion de fosiles. Gutiérrez-Garcia et al. (2013, 2015) han
trabajado con un método que permite obtener digitalizaciones de muy buena
calidad. Su trabajo se fundamenta en la utilizacion de franjas de luz proyectadas
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sobre el material, de este modo se puede recoger informacion muy precisa sobre
la forma y los detalles de la superficie, ademas de dar excelentes resultados en
muestras pequefas, como lo demuestran utilizando una mandibula de raton. Sin
embargo, para una persona con pocos conocimientos sobre la técnica, resulta
complicado de entender y ain mas de experimentar con su propuesta. El uso de
algoritmos y programas matematicos avanzados dificultan en gran medida el
aprovechamiento de sus avances por personas que no pretendan profundizar en
el tema.

Materiales para la creacion de un modelo 3D

1. Hardware

Son todos aquellos componentes informaticos fisicos que ayudaran con la
captura y el procesamiento de las imagenes.

1.1 Camara fotografica digital

Para la creacion de un objeto en 3D a partir de técnicas de fotogrametria no
existe en realidad un requerimiento minimo, sin embargo para obtener resultados
de buena calidad para generar material de estudio y para una correcta
comparacion, se requiere una cadmara que proporcione las mejores fotografias
posibles, no solamente hablando de la cantidad de Megapixeles que pueda dar
por fotografia, sino también otros factores como los sensores de luz, o la
configuracion de la camara, la cual va a variar dependiendo de lugar donde se
realice la captura. A pesar de la libertad que da la técnica de elegir la cAmara y
la configuracion que mejor parezca o con la cual se cuente ya, se recomienda
ampliamente una camara superior a los 5 Megapixeles, la cual, dependiendo del
tamafo del objeto, es capaz dar una calidad aceptable en la textura

FINOTA: En las configuraciones de la camara hay que hacer énfasis en evitar el
uso de filtros fotogréaficos y de retoque ya que éstos modifican los colores de las
texturas. Igualmente, se recomienda limitar el uso de camaras que hagan uso de
objetivos Gran Angular, los cuales lleguen a distorsionar la imagen con el llamado
“ojo de pez”, el cual modifica la perspectiva y las dimensiones del objeto (Figura
3).

Dado lo dinamico de las caracteristicas, existen personas que han logrado
resultados de excelente calidad utilizando la camara de su Smartphone.
Actualmente en el mercado existen algunos que superan ampliamente a camaras
fotograficas.
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Figura 3. El uso de camaras con efecto “Ojo de pez”

1.2 Computadora

La computadora en la cual decida procesa las imagenes necesita cumplir con
ciertas caracteristicas:

Procesador/CPU: Dual-Core a 3.0 GHz o superior
Tarjeta de Video/ GPU: 1 Gb o Superior
Memoria RAM: 2 Gb o superior

Los requerimientos anteriores son los que se necesitan para llevar a cabo el
proceso fotogramétrico, los cuales en realidad no son dificiles ni costosos de
cumplir, pues practicamente cualquier computadora en el mercado de modelo
relativamente reciente los cumple. Una recomendaciéon adicional que puede
facilitar el proceso, es la utilizacién de un monitor de 15” por lo menos, para fines
practicos durante la edicion de los objetos, aunque esto es opcional.

2. Software

Constituyen el conjunto de programas computacionales para el procesamiento
de las imagenes.

2.1 VisualSFM V0.5.26

Se trata de un programa con interfaz grafica que usa la estructura de movimiento
(Structure From Motion o SFM) para la creacién de nubes de puntos en
reconstrucciones 3D. Puede ser descargado gratuitamente desde su pagina
oficial (http://ccwu.me/vsfm/index.html). Se encuentra disponible para Windows,
Linux y Mac OSX, tanto para 32 como 64-bits. No requiere instalacion. Una vez
descargado y descomprimidos los archivos es necesario instalar las extensiones
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para la reconstruccion densa de la nube
(https://github.com/TheFrenchLeaf/CMVS-PMVS/archive/master.zip). El archivo
.zip se descomprime utilizando algun programa como Winrar o Winzip.

En la carpeta que se genera al descomprimir, llamada binariesWin-Linux se
encuentran otras carpetas, de acuerdo al sistema operativo de la computadora
que utilice debe abrir la carpeta correcta. Por ejemplo, si utiliza como sistema
operativo Windows 64 bits -> Win64-VS2010. Copiar todo el contenido de la
carpeta, es decir los archivos individuales y no la carpeta en si, dentro de la
carpeta de VisualSFM de modo que, por ejemplo, el archivo cmvs esté junto con
el VisualSFM.exe

2.2 CloudCompare 2.6.1

Es un programa gratuito para el procesamiento de nubes de puntos y mallas. El
cual sera util para procesar las nubes de puntos que se generaran a partir de las
fotografias con VisualsSFM. Se puede descargar desde su web oficial
(http://www.danielgm.net/cc/) tanto para Windows como para Linux y Mac OS no
disponible para 32-bits en éstos ultimos dos. Su uso no es absolutamente
necesario, sin embargo, presenta ciertas ventajas al momento de recortar nubes
de puntos, en comparacion con su contraparte MeshLab.

2.3 MeshLab V1.3.3

Programa Open source, para manejo de nube de puntos y mallas, muy similar
a CloudCompare, se utilizara principalmente para la creacion de la malla y la
textura. Disponible tanto para Windows como para Mac OSX y Linux. puede
descargarse desde su web oficial (http://meshlab.sourceforge.net/). Como se
vera mas adelante, se sugiere utilizar CloudCompare para las nubes de puntos
y MeshLab para la generacion de la malla y la textura.

2.4 Burst Camera

En caso de que se opte por utilizar una camara fotografica de teléfono celular
qgue funcione con sistema operativo Android, se recomienda ampliamente esta
aplicacion, la cual permite tomar gran cantidad de fotografias a modo de
‘rafaga” lo cual facilita la tarea al momento de la captura. Disponible para su
descarga gratuita desde Google Play
(https://play.google.com/store/apps/details?id=com.samgak.gonnycam)
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3. Elementos complementarios (opcionales)

Se trata de todos aquellos elementos que, aunque no son absolutamente
necesarios, brindan grandes servicios y facilitaran el proceso del modelado.

3.1 Fondo

Durante los ultimos afios la industria del cine ha sorprendido con sus efectos
realistas y animaciones, las cuales en ocasiones son dificiles de discernir de los
objetos “reales”. Para esto se valen de una gran cantidad de elementos, sin
embargo, una variante que ha tomado peso es el uso de Croma, Croma key o
inserciébn de croma, comunmente conocido como “fondo verde” (Figura 5). Se
trata de utilizar un fondo de un color lo suficientemente contrastante con el objeto
principal, para que en el procesamiento posterior sea facilmente detectado y
eliminado. Generalmente en el cine se utilizan fondos azules o verdes, sin
embargo, en este caso se esta tratando con huesos o fésiles, por lo que el fondo
en color verde contrasta mejor con el color que generalmente presentan los
fosiles. Ademas, facilita la edicidén porque evita la presencia de

“ruido” al momento de generar la nube de puntos a partir de las fotografias; es
decir, cualquier objeto ajeno al fosil que pueda interpretarse como parte del
objeto a modelar.

3.2 [luminacién

Para obtener un mejor resultado, es necesario contar con una correcta
iluminacién del objeto en cuestion. El uso de flash puede ser de gran ayuda, pero
es necesario tener cuidado con su utilizacion. En el caso de superficies muy
pulidas o que presenten cierto “reflejo” es necesario abstenerse en la medida
gue sea posible, pues al momento de aplicar la textura al objeto podrian perderse
algunos detalles de la superficie que refleje la luz del flash. Generalmente la luz
natural resulta suficiente para obtener buenos resultados.

Creaciéon del modelo 3D

Para la creacion de un objeto 3D es necesario trabajar con varios tipos de
archivos y elementos los cuales a grandes rasgos son: Fotografias, nubes de
puntos, mallas y texturas. Como se aprecia en el siguiente esquema (Figura 4),
estos son los pasos que se siguen durante la generacion de un modelo virtual
tridimensional. Mas adelante se detalla el proceso que se debe realizar en cada
punto.
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6. Texturizado

5. Creaciondela
malla

3. Edicion de |la nube
de puntos

2. Creacion de la
nube de puntos

1. Toma de
fotografias

Figura 4. Diagrama de procedimiento para creacién de un modelo 3D

Toma de Fotografias

La captura de las fotografias es quiza el paso mas importante para la
construccion de un modelo 3D. Esto puede compararse con cualquier
investigacion, ya que en caso de no capturar la informacion correctamente, todo
el proceso que lleve a cabo con la informacién equivocada o incompleta carecera
de calidad y veracidad.
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Como ya se dijo anteriormente, la iluminacion correcta del objeto dard una mejor
calidad en los detalles que quiera enfocar del modelo, ya que generalmente hay
aspectos que requieren ser resaltados (por ejemplo, los dientes en un craneo).

Area de trabajo:

.

Figura 5. Uso de Croma o Fondo verde para evitar el “ruido” de elementos no deseados en el
modelo, se puede utilizar por ejemplo cartulinas verdes que presentan un color bastante contrastante
con la coloracion que presenta el hueso.

El primer punto a tomar en cuenta durante la toma de las fotografias es que este
método se trata de comparacion entre imagenes. Para que VisualSFM realice
una correcta comparacion entre dos imagenes, éstas deben de ser consecutivas,
por lo que la funcion de “rafaga” incorporada en algunas cadmaras puede ser de
gran utilidad. Para la correcta creacion del objeto se requiere que entre una
imagen y la siguiente exista un 60% de superposicion, en otras palabras, el 60%
de lo que esté en una imagen debe existir en la siguiente. Por esta razén, 3 0 4
fotografias del objeto en sus diferentes caras no son suficientes para obtener el
modelo. A partir de esto surge entonces una pregunta ¢ Cuantas fotografias se
deben de tomar? En realidad, no existe un nUmero absoluto, todo va a depender
directamente del objeto a modelar. Por ejemplo, un hueso largo como una tibia
o un fémur, va a requerir menos fotografias que una estructura tan compleja
como un craneo. En un ejemplo tangible, White et al. (2013) utilizaron un total de
128 fotografias de 10 Mpx para modelar un metacarpal | de un raptor, el cual
media apenas poco mas de 5 cm de largo. Sin embargo, aqui se trataba de un
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trabajo de precision y no se recomienda tomar como base para la creacién de un
objeto pues cada elemento y nivel de detalle requerido sera lo que marcara el
namero de fotografias requeridas.

La técnica para la correcta toma de fotografias consiste en hacerlo de manera
continua. Lo correcto es crear una especie de esfera alrededor del objeto (Figura
6), de manera que todos los angulos queden cubiertos, y respetar la regla del
60% de superposicion. Aqui es donde surge el primer problema ¢ como capturar
la base del objeto? Existen dos maneras de solucionar éste inconveniente. La
primera consiste en realizar las fotografias con el objeto sobre una superficie
transparente, ya sea de cristal o plastico, la cual permita tener una vista de todos
los angulos (ademas de permitir el movimiento de la camara alrededor). El
problema con esta técnica es que se dificulta el uso del Croma o fondo verde, el
cual juega un papel importante al evitar “ruido” en la generacion del modelo. De
modo, se aprecia que puede ser necesario mas de una persona para la toma de
fotografias.

La segunda opcion consiste en girar el objeto. Existen varias maneras de girarlo,
en este punto cada quien es libre de ingeniarse una manera, ya sea montarlo en
una base giratoria o hacerlo simplemente manual, en ambos casos es necesario
seguir la regla del 60% de superposicion con respecto a la ultima fotografia
tomada antes de girar el objeto, ya que es en ese mismo punto donde después
de girarlo debe de continuar. Idealmente se sugiere una base giratoria, sin
embargo, puede resultar dificil encontrar una o fabricar una que se adapte a
todos los tipos de formas, pesos y tamafios de los fésiles, por lo tanto, el girarlo
de manera manual resulta muy util, rapido y barato.
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Figura 6. La captura da fotografias se realiz6 girando el objeto en primer lugar sobre su eje X (Horizontal), una vez girado
por completo se gird sobre su eje Y (vertical) hasta completar todos los angulos.

Después de probar varias técnicas, se puede apreciar como los resultados varian
en funcién de los angulos en que se toman las fotografias, se recomienda iniciar
con fotografias del objeto completo, si es necesario después se pueden realizar
acercamientos a zonas especificas, sin modificar la continuidad entre una foto y
otra, de lo contrario el programa interpretara que se trata de un objeto diferente
y construird otra nube para dicho objeto. Es aconsejable que cada parte, cara o
seccion del elemento aparezca en un minimo de tres fotografias para mantener
un equilibrio entre precision (teéricamente cuantos mas rayos homologos
intersecten en un punto mayor precision podra alcanzarse) y el manejo de un
namero razonable de imagenes y datos. Los puntos a medir pueden ser detalles
naturales bien definidos (bordes, espinas, intersecciones de lineas de
crecimiento con patrones de color, etc.).

Una vez capturadas las fotografias, éstas deben ser transferidas a la
computadora. Es importante que todas ellas sean colocadas en una sola carpeta
donde va a trabajar, manteniendo el orden original en que fueron tomadas.

Creacion de la nube de puntos con VisualSFM

& El uso del Programa VisualSFM requiere gran parte de los recursos

del sistema, por lo cual es recomendable realizar ésta tarea cuando el
equipo no esté ejecutando otros programas que requieran muchos
recursos, de igual maneray como precaucion se recomienda monitorear
las temperaturas del equipo durante el proceso, al menos las primeras
ocasiones

La construccién es un proceso realmente facil y su rapidez sera proporcional a la
velocidad y potencia de la computadora que se utilice.

Para iniciar el programa es necesario ejecutar el archivo VisualSFM.exe que se
encuentra en la carpeta que descargd previamente. Una vez iniciado el
programa, se podra ver dos secciones, una es el espacio de trabajo en blanco y
la otra una ventana pequefia en la cual se mostrara la lista de tareas que se
ejecutan. Se recomienda no cerrar esta ventana en ningun momento, ya que en
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ocasiones el programa aparenta congelarse, pero permanece trabajando en
segundo plano y es esta ventana la que muestra si se continGia ejecutando o no.

Para empezar a trabajar, seleccione dentro de la barra de menu en la lista de file
la opcion Open + Multi images o seleccionando el icono con la carpeta y el
+

simbolo de “+* & |
En la nueva ventana que se abrird, se debe seleccionar la lista de fotografias en
las cuales va a trabajar. Para ello, es necesario buscar la carpeta donde las
imagenes fueron almacenadas y una vez en ella seleccionar todas. Puede ser
con el cursor o con el comando Ctrl+E. El programa es capaz de reconocer varios
formatos: .ppm, .pgm y .jpg siendo este ultimo el mas comun en camaras
fotograficas.

Una vez seleccionadas, aparentemente no sucede nada; sin embargo, el
programa continlia trabajando. Una manera de comprobarlo es dando clic en el
boton derecho dos veces sobre el espacio en blanco y abrird una de las
imagenes. Si se repite el doble clic, se mostrara como carga la vista previa de
todas las imagenes que fueron seleccionadas.

Una vez que todas las imagenes aparezcan en la ventana de tareas del
programa, éste mostrara la leyenda:

“Loading  image pixel data... done in Xs”Donde X
representa el nimero de segundos que tardo en realizar la tarea (Figura 7).

W
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Figura 6. Agregado de imagenes a VisualSFMFig. 7
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Una vez que termine de leer las imagenes que fueron seleccionadas, el siguiente
paso a realizar es calcular las coincidencias entre las imagenes. Esto se realiza
desde el menu SfM->Pairwise Matching-> Compute missing matches o desde el
icono en la barra representado con cuatro flechas de colores que

sefalan hacia el exterior “ . Generalmente este es el paso que toma mas
tiempo al programa, pues durante éste se comparan las imagenes para generar
los puntos de la nube. Como resultado, en la misma carpeta se crearan 2
archivos extras por cada imagen, uno en formato .mat y el otro en formato .sift,
los cuales no deben borrarse pues a partir de estos se generara la nube.

Una vez terminado el proceso, en la ventana de tareas mostrard la leyenda:

“Compute Missing Pairwise Matching, finished. Totally X seconds used”
Donde X representara el nimero de segundos que tardo en realizar la tarea.

El siguiente paso consiste en crear la reconstruccion de la nube de puntos. Esto
se realiza con la funcion Compute 3D reconstruccion o Reconstruct sparse, que
se encuentra en el menu SfM o en la barra de tareas con el icono representado
por dos flechas de color rojo y azul, respectivamente, (sin el

simbolo “+” . . Esta tarea es mas rapida que la anterior y ademas permite ver
como se va generando la nube. Alrededor de la figura aparecen simbolos que
representan las “tomas” o “camaras”; en otras palabras, los angulos desde donde
la fotografia fue tomada. Conforme cargue un angulo el programa, éste ir4
agregando o quitando puntos a la nube. Mientras tanto, el usuario puede girar el
objeto mediante clic en botén derecho, moverlo con clic en botdn izquierdo y
acercarlo o alejarlo con la rueda o scroll del mouse.

Una vez terminado el proceso, se mostrara en la ventana de tareas la leyenda:
Run full 3D reconstruction, finished. Totally X seconds used

Donde X representara el niamero total de segundos que tardo en realizar la
operacion.

Hasta aqui, aparentemente la nube estd completa; sin embargo, es necesario
realizar una reconstruccion densa de la nube. Esto se realiza con la funcion Run
Dense reconstruction o Reconstruction Dense desde el menu SfM o desde

la barra de tareas, representada por el icono con las letras CMVS® i . El
programa solicitara una ubicacion para guardar los resultados y un nombre para
el archivo, una vez indicada, comenzara la tarea. Al finalizar se mostrara el
mensaje:



Run dense reconstruction, finished. Totally X minutes used
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Donde X representara el numero total de segundos que tard6 en realizar la

operacion (Figura 8).
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Figura 7. Reconstruccidon de la nube: los puntos centrales son los obtenidos por la comparacion de imagenes,
los puntos externos representan las “camaras” o angulos desde los cuales fueron tomadas las fotografias,
como se puede apreciar, se dio especial enfasis en la parte basar donde se encuntran la mayor cantidad de

detalles que pueden resultar utiles en la determinacion.

Ya terminada la nube de puntos, es importante asegurarse de

que esté

completamente representado el objeto. Una nube incompleta dara bastantes
problemas mas adelante, especialmente si se trata de objetos complejos como

lo puede ser un craneo.

En caso de que la figura se encuentre incompleta o considere que es necesario
agregar mas fotografias, puede realizarlo dentro de la barra de menu en la lista
de file la opciébn Open + Multi images o seleccionando el icono con la carpeta y

+
el simbolo de “+” =

', después proceder a realizar los pasos nuevamente, los

cuales seran mas rapidos que la Ultima vez debido a que ya se procesaron con

anterioridad las otras fotografias.

Alternativas en la creacion de nubes para computadoras de bajos recursos
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Programas como VisualSFM pueden causar el colapso de computadoras de
bajos recursos tales como notebooks, para casos como estos, existen
alternativas en linea que realizan el proceso en un servidor remoto, por lo que
solamente es necesario cargar las fotografias en dicha plataforma y el cdmputo
de la nube de puntos se realizara a distancia en servidores de altas capacidades
para finalmente arrojarnos una nube de puntos terminada. Sin embargo, al utilizar
dichas plataformas hay que tener en cuenta el hecho de que perdemos
totalmente el control del proceso y la visualizacién del mismo, por lo que pueden
ocurrir casos en los que el servicio en linea realice una interpretacion incorrecta
o incompleta de la reconstruccién, cuando esto llega a suceder podria
dificultarnos el rastrear el error y tendriamos que comenzar de nuevo.

Es necesario para la utilizacién de dichos servicios el contar con una conexion a
internet de alta velocidad para acelerar el proceso, ya que es necesario mandar
todo el lote de fotografias, las cuales entre mayor calidad tengan seran mas
pesadas.

Edicion de la nube de puntos

Para la edicién y retoque de detalles de la nube de puntos, el programa cuenta
con dos opciones: por un lado, MeshLab y por el otro CloudCompare. Si se
decide usar MeshLab, se debe seleccionar la opcién Open Project en el

icono de carpeta & , buscar la carpeta que generé VisualSFM, la cual tiene
una terminacién en su nombre de .nvm.cmvs y seleccionar y abrir el archivo
bundle.rd.out el cual se localiza dentro de la carpeta 00. , Posteriormente se
pedira seleccionar las “camaras”; aunque no son necesarias aun, si son requisito
para continuar, por lo que se debe seleccionar el archivo list.txt. Una vez abierto
el archivo se mostrara la nube de puntos densa, en la cual se puede ver cierto
“ruido” (Figura 9), o dicho de otro modo, puntos que no pertenecen al modelo,
por lo cual es necesario eliminarlos. Aqui es donde quizéa se requiere mas tiempo,
dedicacion y trabajo manual por parte del usuario, pues en realidad en otros
pasos, aunque puedan ser mas tardados la computadora realiza el proceso por
si sola.

Para la limpieza de la nube lo primero es centrar el objeto. Para poder hacer la
rotacion del objeto y colocarlo en el centro de la esfera, hacer doble clic con el
boton izquierdo del mouse sobre la nube central. Para mayor comodidad, mas
adelante se puede utilizar el boton central del scroll del mouse para mover la
nube y centrarla en el circulo de movimiento. Una vez acomodado el objeto de la
manera mas conveniente para su edicion, se debe seleccionar la

(Y ]

) o

herramienta Select vertexes, representada con el icono_""_. Con el botén
izquierdo del mouse y sin soltar se deben seleccionar los puntos que no
pertenezcan al objeto. La seleccion se hace en un plano 2D, por lo que hay que
tener cuidado de no eliminar partes del modelo que se encuentren detras de
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puntos a eliminar. Para ello, es necesario girar el objeto en diferentes posiciones
y angulos para lograr eliminar todos esos puntos innecesarios.

CloudCompare, por otro lado, tiene una herramienta mucho mas completa para
el recortar los puntos de ruido de objeto. En primer lugar, se debe abrir el archivo

desde el icono de la carpeta ¥ Enlaventana que se abre, se debe escoger
el archivo en formato .ply que se obtuvo con VisualSFM. Ya abierto el archivo
aparece una ventana en la cual no es necesario modificar nada, las opciones por
defecto son las que se utilizaran, simplemente seleccionar Apply. Ya con el
archivo en pantalla, hay que asegurarse sobre qué capa se esta trabajando; esto
se ve en el cuadro izquierdo de DB Tree. Para trabajar sobre el objeto hay que
seleccionar la ultima capa del arbol, es decir, la que muestra

el icono de la nube - ; aparecera un cubo alrededor del objeto a editar, ademas
de mostrar las propiedades en el cuadro inferior. Para manipular el objeto el
botdn izquierdo del mouse lo girara sobre el eje central, mientras que el boton
derecho lo movera de posicién en la pantalla.

Oyt

Para recortar el objeto, se debe utilizar la herramienta Segment 7 Una vez
seleccionada, aparecera una pequefia barra de tareas en la esquina superior
derecha, todo lo que hay que hacer es dar click en el boton izquierdo sobre el
borde que divida los puntos de ruido de los puntos del objeto, cada click ira
agregando un vértice de un poligono. Todo lo que hay que hacer es contornear
el objeto de modo que quede dentro del poligono y una vez concluido el contorno
alrededor se da clic con el botén derecho para dar por terminado el poligono.
Para separar lo que esta dentro de lo que esta fuera hay dos opciones; si lo que
se quiere es quedarse con lo que esta dentro del poligono, debe seleccionar la

opcién Segment In ® por el contrario, lo que se encuentra dentro del
poligono es lo que desea eliminar, seleccione Segmento

out O . El proceso, al igual que en MeshLab, se realiza en 2D por lo que hay
que tener cuidado de no eliminar lo que se encuentra al fondo, si es que
pertenece al modelo. Después de cada corte, la segmentacién se pausa y
permite girar el modelo; para reactivar el recorte, es importante presionar el

icono de pausa . Una vez terminado el recorte se debe seleccionar la

figura i para marcar como terminado el recorte. Esto permitira la creacion de
una nueva capa en DB Tree. En caso de que se corte por accidente alguna

parte del modelo, seleccionar L para descartar los cambios hechos. Se
recomienda hacer el proceso en etapas y de vez en cuando dar por terminado el
recorte para crear la nueva capa. Si por alguna razon hay una equivocacion y se
descartan los cambios, se descartaran todos y el proceso descrito con
anterioridad tendra que comenzar de nuevo. En el panel de capas, aquellas que
muestra el Checkbox activado, son las que se mostraran en el area de trabajo;
si se desactiva la casilla de la capa ésta no se mostrara.
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Cuando se aceptan los cambios en el recorte se mostrard una nueva capa
activada y no pareceran cambios aparentemente en el area de trabajo, todo lo
que hay que hacer es desactivar la capa anterior que representa a la figura
original. Y volver a seleccionar la segunda capa con la figura ya recortada para
continuar con el recorte. Para mayor comodidad y si se estd completamente
seguro de los cambios hechos, se puede eliminar la capa anterior con la figura
completa dando Click derecho sobre el nombre de la capa y seleccionar Delete,

X

o presionar el icono

DOFE MO S reoeme sroee) W WM E E NicSOR S

A

Figura 9. Como se puede ver una vez obtenida la nube densa y abriendo con CloudCompare, se puede
ver la gran cantidad de “ruido” presente en la imagen, pero puesto que se utilizé el fondo verde resulta
mucho mas facil identificar los puntos que no pertenecen al modelo deseado.

El proceso con CloudCompare es mas rapido que con MeshLab porque permite
el uso de formas poligonales, en comparacién con la forma rectangular que
ofrece MeshLab Unicamente. Si bien el proceso llega a ser un poco largo y
tedioso, sucede solo al principio, con la practica el proceso se vuelve mas rapido
(Figura 10).

Y

Para guardar el archivo, seleccione el icono de guardar = . El formato en el que
se guarde el archivo sera .ply en BINARY, en el caso de MeshLab en la ventana
gue se abre al momento de seleccionar el icono de guardar, no hay necesidad
de cambiar las opciones, se dejaran las opciones predeterminadas y se guardara
en formato .ply. Se recomienda poner un nombre que facilite reconocer al modelo
ya editado y recortado.
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Figura 10. Nube de puntos limpia.

© Sugerencia: Se recomienda limpiar el monitor o pantalla ANTES de

comenzar a recortar puntos, pequefias manchas, pixeles muertos o polvo
pueden confundirse con partes de la nube de puntos

Creacion de la malla

Para realizar esta actividad es necesario repetir los mismos pasos que al abrir
la nube de puntos con MeshLab. Primero se abre un nuevo proyecto con & ,
después se seleccionan el archivo bundle.rd.out y el archivo List.txt. Ya abierto

-

el modelo, seleccione Import Mesh o y esta vez se debe escoger la nube de
puntos ya recortada y sin ruido que fue editada previamente. Del lado derecho
se abrira el area de capas. Para saber sobre qué capa se esta trabajando, hay
gue asegurarse que ésta esté en color amarillo, ya que en ocasiones vuelve a la
capa anterior. De momento la capa del primer modelo, es decir bundle.rd.out,
con la nube completa no sera necesaria, por lo que se puede desactivar su
visualizacion, para esto es necesario despleiar las opciones de capa en el

. WY s . e l::“‘l
icono “>” al lado del nombre de la capa y seleccionar el icono 4 para

desactivar la visualizacion de dicha capa.

Para continuar con la edicion, es necesario seleccionar la capa de la nube limpia.
El primer paso después de esto es el célculo de las normales, esto es, la
orientacion que recibird cada uno de los pixeles que se generd durante la
creacion de la nube de puntos. Para ello, se debe seleccionar desde el menu de
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Filters>Normals, curvatures and Orientation>Compute Normals for point sets. En
la nueva ventana de opciones conserve los valores que vienen por default,
dejando en Neighbour num o Numero de vecinos un valor de 10, con esto, el
programa tomara como referencia a sus 10 vecinos mas cercanos para orientar
los puntos. Posteriormente se presiona Apply y en la parte inferior se cargara
una barra de proceso de color verde; al finalizar sélo se debe cerrar la ventana
que se emergi6. Una manera de asegurarse de que el proceso se realizo
correctamente es hacer visibles los resultados desde el menu Render>Show
Normal/Curvature y en la nube de puntos se mostraran unas lineas azules
(Figura 11), las cuales en su mayoria deben apuntar al exterior de la nube. En
caso contrario, se debe repetir el calculo de las normales, pero con el valor de
Neighbour num en 50 o 100. El resultado que muestre la mayor cantidad de
normales (lineas azules) que comienzan en un punto y terminan al exterior de la
nube, seré el cual utilizara para el siguiente paso.

& Sugerencia: En éste paso se recomienda guardar el archivo con las

normales calculadas y realizar una nueva inspeccion con CloudCompare
debido a que, con la nueva orientacion de los pixeles, podra notar algunos
gue no eran visibles en sus posiciones anteriores y los cuales ahora se
logran identificar que no pertenecen al modelo a reconstruir.

& MeshLab_64bit v1.3.4BETA - [Project 3]
O File Edit Fiters Render View Windows Tools Help
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Figura 11. Como se puede ver, una vez calculadas las normales (lineas azules), éstas deben de
apuntar hacia afuera del objeto. En éste ejemplo en particular se usé un valor de Neighbour num de 50
ya que con el valor preestablecido de 10, apuntaban hacia adentro del objeto.
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Ya con unas normales aceptables, se puede proceder a la reconstruccion. Esto
se lleva a cabo desde el menu Filters>Remeshing, Simplification and
Reconstruction>Surface Reconstruction: Poisson. En la nueva ventana los
valores a modificar son los siguientes:

Octree Depth: 10
Solver Divide: 8
Samples per node: 1

Surface offsetting: 1

Figura 82. Construccion de la malla.
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Este proceso generalmente es rapido y automaticamente tendra el objeto solido
(Figura 12). Aqui es donde se podra apreciar verdaderamente si se realizdé un
buen trabajo durante la edicion de la nube. Si se muestra una figura diferente a
lo esperado sera necesario cerrar el programa y repetir el proceso de la edicion
de la nube, revisar si se cometid algun error, como haber eliminado parte del
objeto u omitido algun punto de ruido. En cambio, si obtiene una figura que se
asemeje en gran medida al objeto original puede continuar con la aplicacién de
la textura, siempre y cuando la figura obtenida no distorsione partes
fundamentales que puedan ser utilizadas como caracteristicas para la
determinacion de algun elemento éseo. En este punto es donde la ética y la
autocritica puede ser importante si lo que se pretende es compartir el material
con algun fin cientifico o didactico.

Aplicacion de la textura

Para la aplicacion de la textura se deben abrir los archivos bundle.rd.out y List.txt.
Estos son los que daran la textura con base en las fotografias, ademés en una
segunda capa estara la nube ya recortada, ambas nubes, tanto la que se obtiene
con el archivo bundle.rd.out (nube completa) como la que se genero6 después de
recortar, deben estar superpuestas exactamente una sobre otra, esto se hace
automaticamente porque se trata de la misma nube, pero recortada.

En primer lugar, desactive la visibilidad de la primera capa que corresponde a

—

la nube original (bundle.rd.out), presionando el icono ', después asegurase
que esta trabajando sobre la nube recortada (debe estar en color amarillo).

Seleccione la opcibn para agregar textura desde el menud
Filters>Texture>Parametrization + Texturing from registered rasters, esto abrira
una nueva ventana de opciones para aplicar la textura, el Unico parametro que
es necesario modificar en la nueva ventana sera activar la casilla UV stretching,
de modo que la Unica casilla desmarcada sera Use image alpha weight,
seleccione Apply y cargara la textura con base en las fotografias que usé para
generar la nube.
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Figura 93. Imagen en la que se resaltan los detalles de la textura y huesos posteriores del craneo.

El proceso es generalmente rapido y no excede el minuto. Una vez montada la
textura el trabajo esta finalizado (Figura 13), ahora sélo es necesario

seleccionar el icono de guardar 2.4 . En la nueva ventana seleccionar un
nombre y una ubicacion para el archivo de salida el cual estara en formato .ply e
irA acompafado de la textura en formato .png, cuando seleccione Guardar, abrira
otra ventana en la cual no es necesario modificar nada, simplemente presionar
Ok.

Al realizar la aplicacion de la textura del modelo tridimensional en ocasiones
podemos obtener el error referente a “non manifold”, se trata de pequefas zonas
en la maya donde ocurrid un error durante la reconstruccion y no quedaron
debidamente cerradas u orientadas por ejemplo. Para corregirlo seleccionamos
en la barra de menu la opcion Filters > selection > select vertex non manifold
edges, para el caso de que el error nos indique que es referente a vértices o
Filters > selection > select vertex non manifold vertices para el caso de error con
vértices, una vez seleccionados los ssegmentos con error se mostraran en color
rojo en el modelo, generalmente son pequefios y no muy visibles a simple vista
por lo que es necesario buscarlos a detalle sobre la superficie, sin embargo son
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tan pequefos generalmente que pueden eliminarse sin afectar la estructura

general del modelo seleccionando las opciones Delete selected vertices “°
para el caso de vértices o Delete selected faces and

vértices % en caso de que el error persista después desde la barra de menu
la opcion de eliminar vértices seleccionados, la cual esta representada con el
icono del triangulo rojo:

Una vez eliminados los sectores con errores podemos volver a intentar la
aplicacion de la textura.

Finalmente qued6 guardado el objeto 3D con su textura. Para poder usar la
textura simplemente se debe asegurar que ésta se encuentre en la misma
carpeta que la malla, a menos que el programa que se utilice para visualizar pida
seleccionar una textura, en cuyo caso seleccione el archivo .png que obtuvo.

1 Nota: Algunos programas para realizar analisis de morfometria
geométrica pueden tener problemas con archivos que tengan una textura
asociada, por ejemplo, Landmark un programa de morfometria geométrica,
el cual se cierra al agregar las mallas, por lo tanto en estos casos hay que
guardar la malla SIN textura.

Para la creacion del modelo de ejemplo se utilizaron un total de 262 fotografias*,
las cuales fueron tomadas con un teléfono Samsung GT-19100 (Galaxy s2) con
una resolucién de 720X1280 usando la aplicacion Burst Camera.

VisualSFM tardé un total de 168.2 minutos en procesar con un uso normal, es
decir, mientras se realizaba el proceso se realizaban otras tareas como
navegar por internet, redaccion en Word...etc, en un equipo con las siguientes
caracteristicas:

SO: Windows 10
Procesador/CPU: AMD Athlon(tm) Il X2 250 Procesador (2 CPUSs), ~3.0GHz

Tarjeta de video/GPU: NVIDIA GeForce 210
Memoria RAM: 8 Gb

*El nimero de fotografias no debe ser una referencia ya que varia dependiendo del objeto y
que en ésta ocasién por tratarse de un ejemplo y un craneo en particular se decidié obtener los
mayores detalles y precision posible
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Escalar a tamaiio real

En ocasiones el poder realizar medidas sobre el objeto es de gran utilidad
especialmente si se pretende realizar una comparacion con un objeto real. Para
realizar esta tarea MeshLab cuenta con una herramienta de medicion

€

(Measuring tool ). Para utilizarla, se selecciona la herramienta y se da click
en el punto donde se desee comenzar la medicion y con un segundo click el
punto donde se termina la medicion. Sin embargo, cuando lo realice, notara
gue la medida no corresponde a la real, por lo tanto, es necesario escalar el
objeto a tamafio real.

En primer lugar, es necesario obtener el valor de Factor de escala, para saber
cuantas veces es mas grande el objeto real en relacién con el virtual. El método
con el cual se obtiene el valor es simple. Se toman las medidas del objeto real y
se comparan con las medidas del objeto virtual mediante una regla de tres para
obtener el factor de escala. A continuacion, se muestra un ejemplo practico en
el caso de un hueso largo. El largo total del objeto real mide 25.5 cm. Si mide el
objeto virtual exactamente de los mismos puntos y en la misma posicion que el
real, con la herramienta de medicion obtendra un valor generalmente mucho
mas pequeno, por ejemplo 5.3864. En éste caso tenemos que 5.3864 es el
100% del tamafio del objeto virtual, entonces la pregunta es ¢ cuantas veces es
mas grande el objeto real? Simplemente se debe hacer el cdlculo mediante una
regla de tres de la siguiente manera:

Valor del objeto real = Valor virtual = Factor de escala

25.5 +5.3864 = 4.73414525

Tenemos entonces que para este ejemplo el valor de escala es de 4.73414525,
lo que quiere decir que el objeto real es mas de 4.73 veces mas grande.
Considerando los errores de medicion real y virtual, es recomendable realizar
varias mediciones y generar un promedio ya que al tratarse de una medicion en
un plano 2D (virtual) puede tener incertidumbre.

Para realizar el escalado en MeshLab, seleccione la herramienta en
Filters>Normals, Curvatures and Orientation>Transform: Scale. En la nueva
ventana que aparece, en las casillas de X Axis, Y Axis y Z Axis, se encuentra por
default el valor de 1 Indicando que el tamafo es del 100%. Es aqui donde se
debe ingresar el valor promedio del factor de escala obtenido a partir de las
mediciones; en el caso del ejemplo seria 4.734145, el mismo valor debe ir en las
3 casillas y asegurandose que la opcion Uniform Scaling esté seleccionada, para
que realice un escalado uniforme. Una vez generado el modelo a escala real, es
importante guardarlo de la misma manera que se ha hecho anteriormente.

Al tratar de obtener el factor de escala es muy importante realizar las mediciones
varias veces para reducir el margen de error, como ya se menciono, el programa
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realiza la medicidén sobre un objeto de tres dimensiones en una interfaz de dos
dimensiones por lo que se puede obtener una interpretacion erronea del area
que pretendemos medir. La medicion soélo permite hacerla sobre el modelo por
lo que si seleccionamos como punto de partida o finalizacion un punto que no
pertenece al modelo, no realizara la medicion.

Al realizar varias veces el procedimiento podemos obtener valores muy variados
por ejemplo en una primer medicién sobre el modelo real y el 3D podemos
obtener que el modelo real es 3.5 veces mas grande que el virtual, sin embargo
una segunda medicion podemos obtener que solo es 2.8 veces mas grande, en
éste caso hipotético tenemos una diferencia de 0.7 veces el tamafio, podra no
parecer demasiado, sin embargo es % o0 0.2 menos que la primer medida que
obtuvimos, en otras palabras el 20% menor, un valor de 20% de diferencia debe
de considerarse alto si lo que pretendemos es tener una buena precision para
material de investigacion. De esto podemos deducir que alguna de las medidas
no fue realizada correctamente ya sea en el objeto real o en el virtual. Lo
recomendado seria obtener factores de escala con una variacion menor al 7%
en caso de que tras varios intentos no se consiga, es mejor cambiar los puntos
seleccionados para medir y tratar de que los que elijamos sean mas precisos y
faciles de distinguir y medir tanto en el modelo 3D como en el objetivo real. Una
vez que obtenemos valores de factor de escala que no varian en mas de un 7%
entre si, podemos proceder a calcular un promedio y utilizar el promedio como
factor de escala en Meshlab.

F1 Nota: Las medidas obtenidas mediante este procedimiento no deben de
ser consideradas como absolutas, simplemente se trata de una referencia
para realizar comparaciones anatémicas aproximadas.

Una vez gque tenemos nuestro modelo a escala real podemos realizar medidas
mas precisas sobre él e incluso MeshLab nos podra dar informacion sobre su
volumen y superficie desde la opcion: Filters>Quality Measure and
Computations>Compute Geometric Measures, Los datos los podremos ver en la
parte inferior de la barra derecha por debajo de nuestras capas de mallas, aqui
veremos tanto el volumen de nuestro modelo como el area total de la superficie,
éstos datos nos pueden ser de utilidad tanto para la investigacion como para la
impresion de las réplicas

Conclusiones

Como se puede ver, el resultado no es complicado ni tardado de obtener. Sin
embargo, en un principio puede resultar tedioso para quien no se encuentre
familiarizado con el uso de este tipo de programas; todo es cuestién de practica
y no toma mucho tiempo el obtener buenos resultados.

El uso de programas de cdodigo abierto en conjunto con recursos que son
cotidianos (como camaras fotograficas de teléfonos celulares), resulta ser
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bastante econdmico del cual se pueden obtener grandes beneficios a bajos
costos lo cual da gran importancia al uso de esta técnica para la creacion de
material virtual para docencia e investigacion a bajos costos.

Problemas comunes y sus soluciones

PROBLEMA

SOLUCION

MeshLab se cierra al
realizar la reconstruccion
de la malla.

Asegurarse de que su equipo cumple con los
requerimientos minimos para su ejecucion.

VisualSFM no genera la
nube densa (ERROR: the
above CMVS command
failed!).

Asegurarsede haber instalado las extensiones
para la reconstrucciéon densa y/o que se
encuentren en la misma carpeta que VisualSFM.

No se muestra el area de
capas en MeshLab.

Para activar la vista de capas hay que
seleccionar desde el mena View>Show Layer

Dialog o presionar el icono.

La computadora se apaga
al ejecutar VisualSFM.

Un factor importante a considerar es la cantidad
de recursos que consume el VisualSFM, se trata
de un programa que usa gran parte del CPU y la
GPU por lo que trabajan bastante. Algunos CPU
y GPU’s no cuentan con un buen sistema de
enfriamiento, por lo tanto, si no estéa seguro de
las capacidades de su computadora se debe de
estar pendiente de la temperatura del equipo y
prevenir un sobrecalentamiento. Generalmente
los sistemas por seguridad se apagan al
calentarse, pero en casos extremos pueden
dafarse. Para revisar y monitorear la
temperatura del equipo existen diversos
programas, Se recomienda el uso de
HWMonitor.
(http://www.cpuid.com/softwares/hwmonitor.html)

VisualSFM reconstruye
nubes incompletas.

Este es uno de los errores mas comunes con
que se topa el usuario cuando utiliza el
programa por primera vez. El problema radica
en la secuencia de fotografias. Generalmente el
problema es que las fotografias no cumplen con
la regla de 60% de traslape o alguna(s)
fotografias no son de buena calidad, por lo que
el programa interpreta como objetos diferentes y
crea varias nubes en lugar de una.
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Glosario

Codigo Abierto/Open Source: Software que permite ver como esta hecho y
qué hace para modificar y/o mejorar. Los desarrolladores de éste tipo de
programas deciden hacer publica la manera en la que esta hecho su programa
para que otros desarrolladores puedan manipularlo y mejorarlo si asi lo desean.

CPU: Unidad Central de Procesamiento, hardware de la computadora
encargado de interpretar las instrucciones y érdenes de un programa, llamada
generalmente el cerebro de la computadora. (ej. Intel Core Duo, AMD Athlon Il
etc.).

GNU: Sistema operativo de software libre que permite a los usuarios ejecutar,
copiarlo, distribuirlo, estudiarlo y mejorarlo.

GPL: Licencia Publica General.

GPU: Unidad de procesamiento grafico. Coprocesador dedicado al
procesamiento de graficos. La mayoria de las computadoras cuentan con una
integrada a través de una llamada tarjeta de video, en muchos casos de gama
baja o de limitadas caracteristicas y potencia, por lo cual puede agregarse
como complemento dentro del gabinete de la computadora. En el caso de
laptops existen algunas que traen integradas algunas bastante potentes. (Ej. de
tarjeta para PC de escritorio Nvidia G210, GTX750ti, AMD R7 250x etc.).

Megapixel: Unidad que contiene un millén de pixeles.

MeshLab: Programa para el procesamiento de mallas 3D y manejo de datos
(http://meshlab.sourceforge.net/).

Pixel: Superficie homogénea méas pequefia que compone una imagen digital,
gue se define por su brillo y color.


http://meshlab.sourceforge.net/
http://meshlab.sourceforge.net/
http://meshlab.sourceforge.net/
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Anexo

Ejemplos de huesos virtuales tridimensionales obtenidos con la técnica de
fotogrametria, en la cual se utilizé un teléfono con cAmara de 8 Megapixeles y
una computadora con las siguientes caracteristicas (Figura 14, 15y 16):

Procesador/CPU: AMD Athlon(tm) Il X2 250 Procesador (2 CPUSs), ~3.0GHz
Tarjeta de video/GPU: NVIDIA GeForce 210
Memoria RAM: 8 Gb

Figura 104. Molar dp2 perteneciente al género Mammuthus aportada por el Museo de
Paleontologia de Guadalajara, Federico A. Solérzano Barreto. Numero de catalogo: MPG-R-6055.
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Figura 15. Molares de camello aportados por el Museo de Paleontologia de Guadalajara, Federico A.
Soldérzano Barreto. Numero de catalogo: MPG-R-2008.

Figura 16. Himero de Equus aportada por el Museo de Paleontologia de Guadalajara, Federico A.
Solérzano Barreto. Numero de catalogo: MPG-R-1655.
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Conclusiones

La fotogrametria es una técnica basada en principios desarrollados hace
décadas, sin embargo, con las nuevas tecnologias las técnicas se han
diversificado y perfeccionado. Hoy es facil crear una réplica de un modelo
tridimensional virtual sin invertir practicamente un solo centavo, a pesar de la
facilidad, cosa que se puede notar durante la lectura de este manual, muchos
investigadores, profesores y alumnos desconocen totalmente las técnicas y los
beneficios que estas aportan, entre los que mas destacan son:

1. La preservacion del patrimonio cultural: a través de la creacion de réplicas
de objetos de alto valor histérico, podemos asegurar copias fieles de la
morfologia, colores y texturas de estos objetos, con lo cual beneficiamos
a las futuras generaciones en caso de la pérdida, destruccién o desgaste
de las piezas originales, algo de vital importancia dentro de la
paleontologia.

2. Material didactico novedoso: Gracias a los modelos virtuales tanto
alumnos como maestros se ven beneficiados en cuanto al aprendizaje y
entendimiento de la biologia, evoluciéon y paleontologia, ampliando el
panorama de observacion ahora puede resultar mas facil entender cosas
que las simples fotografias no nos permitian antes, tales como la forma y
la profundidad de ciertos objetos. Esto no se restringe a maestros y
alumnos, también a museos y visitantes, los cuales pueden tener una
experiencia mas agradable al poder manipular ya sea una réplica virtual o
una réplica exacta impresa en 3D.

3. Investigaciones mas precisas: ahora los investigadores son capaces de
compartir sus resultados y descubrimientos de una nueva manera, no
necesitan viajar a otra ciudad para ver un elemento y poder medirlo ya
que esta informacién puede ser generada y compartida por otros
investigadores que tengan mas facil acceso al elemento. Ademas,
permiten el realizar analisis de morfometria geométrica utilizando las tres
dimensiones reales que tiene el objeto y no solo las dos dimensiones que
proporcionaba la fotografia, con lo cual los resultados obtenidos tienen
mayor peso.

4. Entretenimiento: Las réplicas incluso pueden utilizarse para la generaciéon
de material de entretenimiento, un ejemplo seria con un modelo
tridimensional del cuerpo completo de un animal extinto, el cual sin
dificultad se puede animar y crear material para peliculas, documentales
0 series animadas. Con la ventaja de que proporcionan una
representacion mas fiel a las generadas actualmente.
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Paginas web de interés

¢ 3D Museum. htip://3dmuseum.org/

«  Digimorph, produced by members of the Digital Morphology Group, in
conjunction with The University of Texas High-Resolution X-ray Computed
Tomography Facility. http://digimorph.org/index.phtml

+  GB3D Type Fossils by the British Geological Survey and copyright on the
website is with the JISC GB3D Type Fossils Online project partners.
http://www.3d-fossils.ac.uk/home.html

- Real 3D Anatomy: all content copyright © University of Bristol & Creative
Dimension Software Ltd 2011 http://www.real3danatomy.com/index.html

+ UMORF Online Repository of Fossils, Museum Of Paleontology. University of
Michigan.: https://umorf.ummp.lsa.umich.edu/wp/

Links al proyecto derivado de este trabajo:

*  Blog: Project Animus 3D projectanimus3d.blogspot.com.mx

*  Web: Museo Virtual Nacional www.museovirtualnacional.com

« Archivos de ejemplo y para practicar:_https://mega.nz/#F!xg2nA7CI9xP3 Oe-
MboD3WGQyu36Bg
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